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CHS Publications Template

How to Tag with Style

CHS Publications Team

Revenge is a dish best served cold. 

Old Klingon proverb, often attributed to Choderlos de Laclos

This style guide includes a template that will allow you easily to format a manuscript for the CHS production process. Before going further, you may want to print (or make a pdf of) these instructions so that you can refer to them as you format the manuscript. You can also always open another copy by double-clicking the chs_template.dotx file.
0. Getting Started
If you opened this document by double-clicking the chs_template.dotx file, you should see that the file name at the top of the window is something like “Document1.” 
 

Each chapter (vel sim.) of the manuscript should be a separate Word document. Items of front and back matter (contents, acknowledgments, bibliography, etc.) should also each be a separate file. Footnotes should begin again from “1” in each file. 

Starting with one chapter of the manuscript, first select and delete all the text in this document and paste in the text of the chapter. Repeat the process, opening a new document from the original chs_template.dotx file, for each chapter. Once your text is pasted into the template you are ready to apply style tags that will give the text the correct formatting.
What is style tagging?
Style tagging is the process of specifying the role of a portion of text (e.g. a chapter title, a normal paragraph) and, based on that role, to set how the text looks; this also ensures an appropriately structured text. Each style (its font,
 alignment, etc.) is pre-formatted to look a certain way. For example, at the beginning of this document are four “paragraphs,” each tagged with the style that matches its function: from the top, they are chapter_number, chapter_title, chapter_subtitle, and essay_author. By using styles, you will not need to remember—or repeatedly consult this document to see—whether the subtitle should be in a 14 or 16 point font size, bold or not. You just need to know that it is a subtitle. See the section entitled “Important Tips for Applying Style Tags” near the end of this document for recommended ways to apply the tags themselves.

It is important that you do all formatting with styles and that you do not override the styles
 manually (for example, resist the temptation to click the “italics” or “centering” buttons); such manual formatting will be lost later. Be aware that you are not preparing “camera-ready” copy; the appearance of your book, in print and/or online, will differ from this document. Speedy and accurate compositing depends on the manuscript being tagged properly. 

Almost all the styles that you will apply are prefaced with “chs.” For simplicity, this “chs” is normally omitted in the discussion below, but please use only “chs” styles, unless otherwise instructed. Every CHS style tag also has an abbreviation consisting of two or three letters that appears after the comma in its unabbreviated name. For ways to use the abbreviations, see the “Important Tips for Applying Style Tags” section near the end of this document.

1. Paragraph Styles

There are two main categories of style: paragraph and character. A paragraph is anything followed by a “return” (i.e. a “carriage return”). Every paragraph in your manuscript must be tagged with a paragraph style, which will apply to the entire paragraph. To tag a paragraph, place your cursor anywhere in the paragraph (or select multiple paragraphs) and apply the appropriate style by choosing it from the floating palette labeled “CHS Styles”.
 That’s it. So to format a chapter title, you simply place your cursor anywhere in the title and choose chapter_title, rather than selecting the whole line and setting it as 16 point Lucida Grande, centered, bold (four times as many steps).

1.1 Chapter openings

1.1.1 chapter_number,cn

Use arabic numerals. Some chapters (preface, bibliography) may have no number, in which case insert an empty line with this tag.
1.1.2 chapter_title, cht and chapter_subtitle,cs

Used for the title (chapter_title) and subtitle (chapter_subtitle) of a chapter within a monograph or an essay within an edited volume. Note that subtitles have their own paragraph style and so must be placed on a separate line (rather than being separated from the title by a colon). Each should occur only once within a given document. Capitalize headline-style.

Note that the style tagging does not capitalize for you, but here’s a tip for remembering the CHS rules: if the style tag aligns something as centered (as with the chapter title and subtitle) use headline-style capitalization. If the style tag aligns to the left, use sentence-style. 

1.1.3 essay_author,ea

Used for the name of the author(s) of an essay in an edited volume.
1.2 “Normal” text paragraphs

1.2.1 chs_normal,no and normal_posthead,nph

Paragraphs immediately following a heading, like this paragraph, are traditionally not indented. The style for this is normal_posthead. 
Regular text paragraphs, like this one, are tagged as simply chs_normal. The first line will be indented automatically; no tab is needed.
1.2.2 normal_continue,nco

The normal_continue style is used for the continuation of a paragraph that has been interrupted by other paragraph-level formatting, such as a blockquote (1.4) or lines of verse (1.5). It will appear unindented; for an example, see 1.4 below.

1.3 Subheads

Three levels of subhead are available for divisions within a chapter: h1, h2, and h3 (which are also their abbreviations). All have been used already in this document: h1 (“1. Paragraph Styles”), h2 (“1.1 Chapter openings”), and h3 (1.1.1 chapter_number,cn). 
First-level subheads (h1) are capitalized headline style; second- and third-level subheads (h2, h3) within a chapter/essay are capitalized sentence-style. For a tip on remembering this, see above under 1.1.2.
If headings are numbered (and numbering is encouraged if you use more than one level), use arabic numerals separated by dots, in line with the heading (as in this document).
We discourage the use of further subdivision in our books, but if your work requires such subdivisions, please consult with us on how to proceed.

1.4 Blockquotes

Prose quotations of about three lines or longer should be placed in their own paragraphs, without surrounding quotation marks, and tagged with the blockquote,bq style. Left and right indention, as well as space above and below, are applied automatically.

τελευταῖα δὲ ἐν τῇ γραφῇ Πενθεσίλειά τε ἀφιεῖσα τὴν ψυχὴν καὶ Ἀχιλλεὺς ἀνέχων ἐστὶν αὐτήν: καὶ Ἑσπερίδες δύο φέρουσι τὰ μῆλα ὧν ἐπιτετράφθαι λέγονται τὴν φρουράν.

Pausanias 5.11.6

If the blockquote is followed by a source attribution, like Pausanias above, see 1.6 below for the appropriate tag. This very paragraph is our delayed example of the normal_continue,nco style (see 1.2.2 above), since this paragraph continues the one begun before the blockquote.

1.5 Verse lines

Verse quotations of three or more lines should be set apart from the text (shorter quotations may be run in [see. 4.4.1, below] or set apart), with each line ending in a return and tagged verse_line,vl. Please insert a tab at the start of each line, but after any line number (see 1.5.1). If a line needs to be indented (like the pentameters of the elegiac couplets below), please use one additional tab. Very long lines will wrap automatically; please do not force the formatting by inserting extra returns or tabs.


ausa ferox ab equo quondam oppugnare sagittis



Maeotis Danaum Penthesilea rates;

15
aurea cui postquam nudavit cassida frontem,



vicit victorem candida forma virum.
 

Propertius 3.11.13–16
If you wish to omit an entire line (or lines) from the middle of a longer verse extract, indicate the omission with a “vertical ellipsis” (a row of spaced dots approximately the length of the preceding line [or of the missing line]).

924
αὐτὸς δ’ ἐκ κεφαλῆς γλαυκώπιδα γέινατ’ Ἀθήνην,


. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

927
Ἥρη δ’ Ἥφαιστον κλυτὸν οὐ φιλότητι μιγεῖσα


γέινατο,

Hesiod Theogony 924–928
1.5.1 Verse numbers

If using line numbers, place each number at the start of its line, before the tab(s). They are tagged with their own character style: verse_number,vno. To apply a character style, simply highlight the characters that you wish to format, and then choose the style. For more on how to tag only certain characters within a paragraph, see section 2 “Character Styles.”

1.6 Source attribution

Source attributions following verse lines or blockquotes should be in a separate paragraph tagged source_attrib,at without parentheses. The alignment to the right is built into the style; please do not use using tabs or spaces for this. Examples can be seen above under “Blockquotes” and “Verse lines” (1.4, 1.5). A translator may be also be credited in a source attribution line.

1.7 Lists

Multiple formats are available for lists: simple (unmarked), bulleted, numbered (which may include another numbered list nested within it), and definition lists. Each has a paragraph style that is to be applied to each item in the list.
1.7.1 listsimple_item,ls

The most basic type is an unmarked (“simple”) list. Lists tagged with this style will simply indent with no further markings. 

Lily Chou Chou

Isaac Hayes

Meiko Kaji

Robert Rodriguez

1.7.2 listbullet_item,lb

Will automatically place a bullet before each item. 

· Luis Bacalov

· Ennio Morricone

· Nora Orlandi

· Armando Trovajoli
· Riz Ortolani
1.7.3 listnumber_item,ln and listnumber2_item,ln2

These tags are used to make ordered, numbered lists. Listnumber_item is the first (and in most cases only) style you should use for your numbered lists; this will render with a number next to each item. If you require a different numbering sequence (e.g. A, B, C or i, ii, iii), please type this in your paragraph—your document will display both an Arabic numeral and your preferred system, but we will be able to fix this in the final document. In addition, there is one currently unresolved display issue: numbering remains consecutive throughout the document. Please do not worry about this: it is a quirk of Word, and upon conversion to digital format your lists will have separate numbering systems.

Listnumber2_item is the tag for a nested numbered list, i.e. a numbered list that appears within another numbered list. As with listnumber_item, lettering will, through an unfortunate quirk of Word, be continuous throughout the document. If your first-level list continues after the nested list, please return to using listnumber_item.

1. Volume One

a. The Origin of O-Ren

b. The Man from Okinawa

c. Showdown at House of Blue Leaves

2. Volume Two

d. The Cruel Tutelage of Pai Mei

e. Elle and I

f. Face to Face

1.7.4 listdef_term,ldt, listdef_description,ldd, and list_continue,lc

Another type of list is a definition list, in which a series of terms is defined at greater or lesser length. Below is a list of the members of the Deadly Vipers. The codenames are tagged listdef_term,ldt. The real names are tagged listdef_description,ldd. If your description or definition requires a second paragraph, please tag it list_continue,lc (not illustrated).
Black Mamba

Beatrix Kiddo

California Mountain Snake

Elle Driver

Copperhead

Vernita Green

Cottonmouth

O-Ren Ishii
1.8 Illustrations, tables, and captions
All illustrations must be explicitly referenced in the text with a callout such as “(Figure 1).” References should be to “Figure 1” or “Plate 1” (not “fig. 1” or “pl. 1”). Use a double-bracketed indicator, on its own line between two paragraphs, to indicate roughly where the image(s) should be placed and, optionally, how they should be arranged, e.g. “[[Insert Figures 1 and 2 on facing pages]].”
Artwork, along with a list of captions, should be supplied separately from your manuscript. Each caption must begin with a label in the form “Figure 1” or “Table 1.” Use this template for the caption list as well, tagging each caption as caption,cp and using any other necessary character styles (see section 2, below).
Tables may be included within the manuscript, but bear in mind that the useable text block of the printed book is considerably smaller than 8.5 x 11 in. Tables may need to be rotated, broken across pages, or moved within the manuscript during layout. A table may have a heading (tagged as h3) and/or a caption (tagged as caption). For the table itself, use Word’s default formatting and any character styles needed (see section 2, below). 
1.9 Footnotes

Footnote text is its own paragraph style (not a chs style) that Word applies automatically, when you use the Footnote command under the Insert menu. While a footnote may have more than one paragraph, if you have a footnote that is unusually long, please consider making it an appendix or an endnote.
Other paragraph styles are not normally needed in footnotes. Block quotations, for example, should be avoided in notes.
2. Character Styles

Character styles are used to tag words (or parts of words) within a paragraph, superseding the paragraph style for the selected word(s) only. If something needs to be italicized, such as a book title, please do not simply press the “italics” button in Word, but rather tag the word(s) with the appropriate style (in this case, citetitle [2.3.1]), even if the characters are already formatted without the use of a style.

To apply a character style, select the text and then choose the style in the same way as a paragraph style (see section 4 below, “Important Tips for Applying Styles”). To undo a misapplied character style, select the text and choose the style Default Paragraph Font (not a chs style) or hold the “control” key while hitting the space bar. This will revert to the underlying paragraph style.

2.1 Non-default languages

2.1.1 foreign,cf

Isolated words and phrases in languages other than the default language of the manuscript should be tagged as foreign, if in roman letters: “[I] speak Japanese hěn hǎo.”
 Fully naturalized words are not italicized and require no tag (e.g. résumé and alter ego in English). Transliterated Greek is a special case; see 2.1.2 translit_Greek, below.
Short foreign quotations are enclosed in quotation marks and not tagged: “Nǐ shì lái xué wǔ de, bù shì xué jiǎnghuà.”
 For longer quotations, see above under “Blockquotes” (1.4) and “Verse lines” (1.5), where the foreign character tag is not used either. 
2.1.2 translit_Greek,trl

Used to tag isolated words and phrases in transliterated Greek.
2.1.3 Greek,gk and Latin,lt

Words, phrases, and short quotations (i.e. those not set as blockquotes or verse lines) in Greek or Latin should be tagged with the character style Greek or Latin (without quotation marks around the Greek or Latin): “Although she bears the arms of Diana/Artemis (Aeneid 11.652), who is ἐύσκοπος (Odyssey 11.198), Camilla dies while fighting certamine pugnae caeca
 (Aeneid 11.780–781).” The Greek tag will have no visible effect; the Latin will italicize. As with other languages, Greek and Latin in blockquotes and verse lines require no character tag.
Please do not use the Latin tag for academic abbreviations; see the end of 2.2, “Emphasis vs. highlight,” below. 
2.2 emphasis,em vs. highlight,hi

Emphasis is always that of the original speaker/writer, whether the author of the work being tagged or someone that author is quoting. The emphasis style is used throughout this document, most recently in the previous sentence. Here is an utterance with the original speaker’s emphasis tagged as emphasis: “What Clark [Kent, Superman’s alter ego] wears—the glasses, the business suit—that’s the costume.”
 The speaker is emphasizing the point that, unlike most superheroes whose outlandish costumes conceal their true identities, Superman’s disguise is normal clothing.

Now suppose I am writing about the stereotype of eyeglass-wearers as weaklings. I might quote the utterance above to show that no one who wears glasses would be suspected of leaping tall buildings in a single bound. To draw my reader’s attention to the glasses, I might quote the line this way “What Clark wears—the glasses [my emphasis], the business suit—that’s the costume.” The style used to draw attention to something in a quotation is highlight; you may think of this as “quoter’s emphasis” but the style name is highlight. In a printed book, highlighted words will also appear italicized, so there should always be wording such as “my emphasis” (even though the style is called highlight). Please remember not to use the italics command for either highlight or emphasis; just tag appropriately and let the style do the work.

If something needs to be tagged as both foreign and emphasized, use the style foreign_emphasis,fe. 
The emphasis tag is also used for ad, ad loc., and sic, which are normally italicized. Other common academic abbreviations (such as e.g., i.e., s.v., cf.) are not italicized and hence not tagged. 
2.2.1 Greek_high,ghi, Latin_high,lhi, foreign_highlight,fhi, and translit_Greek_high,thi

Since emphasis, in the sense described above, is not marked in ancient texts, the emphasis,em style should never be used in quotations of Greek or Latin. Drawing attention to something in an ancient text is again what we call highlight,hi. If you need to tag something as both Greek and highlighted, use Greek_high,ghi: “Compare θηροσκόπος ἰοχέαιρα (Homeric Hymn to Artemis 27.15) with ἐύσκοπος ἰοχέαιρα (Odyssey 11.198).”

To point out the figura etymologica in Propertius 3.11.16, the words would be tagged with Latin_high,lhi: vicit victorem candida forma virum. 

Foreign_highlight,fhi and translit_Greek_high,thi combine the effects of the foreign,cf and highlight,hi styles and the translit_Greek,trl and highlight,hi styles, respectively. Cf. foreign_emphasis,fe (under 2.2, above).

2.3 Titles

2.3.1 citetitle,ct

Titles of works that are italicized (books, journals, and monographs) should be tagged citetitle wherever they appear, e.g. Homer’s Iliad. If a subtitle is included, the whole unit is tagged citetitle, e.g. Pindar’s Verbal Art: An Ethnographic Study of Epinician Style.
Article titles, vel sim., that are enclosed in quotation marks are only tagged in bibliographies, on which see section 3.1.1 below. 

2.3.2 citetitle_common,ctc

Used for common titles or abbreviations that are not normally italicized, such as FGH, IG, or The New Testament, which are in fact tagged here, although their appearance is unchanged.

2.4 Other character styles

2.4.1 msfam,msf

Use to designate a family of manuscripts, as b (BCE3).

2.4.2 subscript,sb

Use for a numeric or alphabetical subscripted number or letter, usually to denote an index number, as h3, ra2.

2.4.3 superscript,ss

Use for a numeric or alphabetical superscripted number or letter to denote an edition of a work or the like, as IG2.

3. Bibliography 

This section discusses styles to use in bibliographies and how to structure various sorts of entries. Begin by tagging the heading “Works Cited” or “Bibliography” as h1.
3.1 Bibliography styles

biblio,bib is the paragraph style for all entries in a bibliography; it will automatically create a hanging indent (please do not force line breaks or use tabs for this). Within each entry, apply the following character styles. Please do not tag punctuation of any kind in a bibliography unless it is part of the title, as in the titles Who’s Afraid of Virginia Woolf? and Help!
3.1.1 Titles

Titles of books, journals, monographs, etc. should be tagged citetitle,ct. See also “Titles” (2.3 above). Note that titles of monograph series are not italicized and hence not tagged. 

The character style for titles of articles and contributions to edited volumes is arttitle,art. 

3.1.2 bibauth,ba

Used for names of authors. 

3.1.3 bibed,be and bibtrans,bt

Used for names of editors and translators, respectively.

3.1.4 bibyear,by

Used for years of publication. 
3.2 Components of a bibliography entry

The main components of the entry (e.g. author/editor name, year of publication, title, place of publication) are normally separated by periods, not commas.

3.2.1 Personal names and arrangement of entries
Initials. Two or more initials are separated by a space.

Lord, A. B.
Names with particles. The alphabetizing of surnames that include particles (di, de, van, von, etc.) depends to some extent on the preference of the individual in question, if known, or how the person is commonly known. Please use the following alphabetized list (abridged from CMS 16.71) as a guide.

Beauvoir, Simone de

Ben-Gurion, David

Costa, Uriel da

da Cunha, Euclides

de Gaulle, Charles

Keere, Pieter van den

La Fontaine, Jean de

Medici, Lorenzo de’

Van Renssalaer, Stephen
Names beginning Mac-, Mc-, O’-, Saint, Sainte, or St. are alphabetized letter by letter, with punctuation ignored. 
Works by a single author/editor. All works by an individual are listed chronologically, whether the person is author or editor. For works after the first, a triple em-dash (see 4.3.3, below) replaces the name. Any punctuation and/or role that would normally follow the name (e.g. “, ed.”) is kept.

Dué, C. 2006. The Captive Woman’s Lament in Greek Tragedy. Austin.
———, ed. 2009. Recapturing a Homeric Legacy: Images and Insights from the Venetus A Manuscript of the Iliad. Cambridge, MA.

———. 2010. “Agamemnon’s Densely-Packed Sorrow in Iliad 10: A Hypertextual Reading of a Homeric Simile.” In Tsagalis 2010, 279–299.
Works by two or more authors/editors. Only the name of the first person is inverted and a comma follows the given name or initial(s) of that person. Subsequent names are not inverted.

Dué, Casey, and Mary Ebbott. 2010. Iliad 10 and the Poetics of Ambush: A Multitext Edition with Essays and Commentary. Cambridge, MA.

Multiple works with the same authorship/editorship. List these after all works by the first author/editor alone. The name(s) of the author(s)/editor(s) are replaced by a triple em-dash only when all the author(s)/editor(s) are the same, even if the roles are different. 

Yatromanolakis, D. 2007. Sappho in the Making: The Early Reception. Cambridge, MA.

Yatromanolakis, D., and P. Roilos. 2003. Towards a Ritual Poetics. Athens.
———, eds. 2004. Greek Ritual Poetics. Cambridge, MA.
3.2.2 Year of publication

Multiple works in a given year by the same author(s)/editors(s). Append a letter to the year of each work. Within the year, arrange works alphabetically by title. Whether the works are authored or edited is not a factor in the arrangement.

Johnson, S. F., ed. 2006a. Greek Literature in Late Antiquity: Dynamism, Didacticism, Classicism. Aldershot.

———. 2006b. The Life and Miracles of Thekla: A Literary Study. Cambridge, MA.

Works that span more than one year. In accordance with the general guidelines for numbers, give both years in full, separated by an en-dash (see 4.3.2, below).
Forthcoming works. Use “Forthcoming” in place of a year. 
 Bonifazi, Anna. Forthcoming. Homer’s Versicolored Fabric: The Evocative Power of Ancient Greek Epic Word-Making. Cambridge, MA.

Undated works. Use “n.d.” in place of a year. 
Second or later and reprint editions. It is normally only necessary to cite the edition actually used. For later editions, the original publication date (and place, if different) may be added at the end of the entry. If citing the original edition, reprint information may be added. 
Dontas, Nikos, and Kleopatra Ferla, eds. 2005. Priene. 2nd ed. Athens.

Lord, A. B. 2000. The Singer of Tales. 2nd ed. Cambridge, MA. Orig. pub. 1960.

Nagy, G. 1979. The Best of the Achaeans: Concepts of the Hero in Archaic Greek Poetry. Baltimore. Repr. 1999.
Translations. When listing a translation of a modern work, the original title and publication details may be added at the end of the entry.

Detienne, M., and J. P. Vernant. 1989. The Cuisine of Sacrifice among the Greeks. Trans. P. Wissing. Chicago. Orig. pub. as Cuisine du sacrifice en pays grec. Paris, 1979.
3.2.3 Titles and subtitles

The spelling of titles should normally not be altered. Original punctuation within the title (and within the subtitle) should also normally be preserved, except for the changing of guillemets to quotation marks. Tag as described under 3.1.1, above.
Titles and subtitles in English. Capitalize in headline-style (the first, last, and all other major words are capitalized). See the examples in 3.2.1 and 3.2.2.
Titles and subtitles in other languages. Capitalize in sentence-style (the first word of both the title and subtitle are capitalized; otherwise only capitalize words that would be in normal prose of that language [e.g. nouns in German, proper names in most languages]). Note that a definite or indefinite article counts as the first word.

Les jardins d’Adonis
Pratiques poétiques de la mémoire: Représentations de l’espace-temps en Grèce ancienne
Der Chor in der alten Komödie: Ritual und Performativität
The title and first subtitle are separated by a colon.
Tragedy, Authority, and Trickery: The Poetics of Embedded Letters in Josephus 

If there is a second subtitle, it is preceded by a semi-colon.

“‘Riddles over Riddles’: ‘Mysterious’ and ‘Symbolic’ (Inter)textual Strategies; The Problem of Language in the Derveni Papyrus”
Titles of journals. Give all titles in full. Capitalize in the same way as other titles.

Harvard Studies in Classical Philology
Rivista di filologia classica
Zeitschrift für Papyrologie und Epigraphik
Titles of series. Names of monograph series are not italicized and hence not tagged. See the example below under “Monograph in a series.” For a series of a journal (e.g. “new series”), see the Classical Quarterly example under “Article,” below.
Italicized words within italicized titles. If text that would normally be italicized (such as a book title or non-English word in an English title) occurs within a title that is already italicized, use “reverse italics,” by tagging with the “Default Paragraph Font” style.
Eve of the Festival: Making Myth in Odyssey 19
The Anger of Achilles: Mēnis in Greek Epic
Similarly, items that would normally be in double quotes may be part of a title that requires quotation marks of its own. In such cases, the internal set is converted to single quotes.

Badian, E. 1999. “A Note on the ‘Alexander Mosaic.’”

Blondell, Ruby. 2006. “Where is Socrates on the ‘Ladder of Love’?”

Dignas, Beate. 2008. “‘Greek’ Priests of Serapis?”

3.2.4 Places of publication

The English version of a place name should be used, if one exists, e.g. Turin [not Torino] and Munich [not München].

Two or more places of publication. Give only the first. 
U.S. state abbreviations. These are not needed unless they are likely to be confused with another city, e.g. “Los Angeles” but “Cambridge, MA” as opposed to “Cambridge” (England). If needed, use current postal abbreviations (e.g. “MA” not “Mass.”), regardless of what appears in the original publication. Note that this differs from the guideline of CMS, which recommends adding state abbreviations for smaller, less familiar cities.

Country names. Only use to avoid ambiguity; cf. “U.S. state abbreviations,” above.
3.3 Types of works

Book

Frame, Douglas. 2009. Hippota Nestor. Washington, DC.

Edited volume

Luraghi, N., and S. E. Alcock, eds. 2003. Helots and Their Masters in Laconia and Messenia: Histories, Ideologies, and Structures. Washington, DC.
Contribution to an edited volume or a collection cited elsewhere
When citing more than one contribution to the same edited volume, please list the volume separately (in the “Edited volume” format, above) and use this “Contribution to an edited volume or a collection cited elsewhere” format for the contributions.

Raaflaub, K. A. 2003. “Freedom for the Messenians? A Note on the Impact of Slavery and Helotage on the Greek Concept of Freedom.” In Luraghi and Alcock 2003:169–190. 
Note that it is not necessary to add “eds.” after the name(s) of the editor(s) since the book is understood to be an edited volume; “eds.” appears in the full entry (see “Edited volume,” above).

Contribution to an edited volume or a collection not cited elsewhere 

Stephens, S. 2004. “For You, Arsinoe …” In Labored in Papyrus Leaves: Perspectives on an Epigram Collection Attributed to Posidippus (P.Mil.Vogl. VIII 309), ed. B. Acosta-Hughes, E. Kosmetatou, and M. Baumbach, 161–176. Washington, DC.
Note that the names of the editors are preceded by “ed.” not “eds.” In this position, “ed.” stands for “edited by” not “editors.” The editors’ names are not inverted since they are not in an alphabetized list here.
When the author/editor of the contribution is the same as for the volume as a whole, there is no need to repeat the name.

Slatkin, Laura M. 2011. “The Wrath of Thetis.” In The Power of Thetis and Selected Essays, 72–85. Washington, DC.
Monograph in a series

Segal, Charles. 1971. The Theme of the Mutilation of the Corpse in the Iliad. Mnemosyne Supplement 17. Leiden.

Work published as multiple volumes

Bloch, H. 1986. Monte Cassino in the Middle Ages. 3 vols. Cambridge, MA.

Note that “vols.” is not capitalized after the number.

One volume of a multi-volume work

Watkins, Calvert. 1994. Selected Writings. Vol. 1, Languages and Linguistics. Ed. Lisi Oliver. Innsbruck.


or

Watkins, Calvert. 1994. Languages and Linguistics. Vol. 1 of Selected Writings. Ed. Lisi Oliver. Innsbruck.
For volumes without titles, a roman numeral may be appended to the title, e.g. “Selected Works I.”
Edition of an ancient work

These are normally listed under the name(s) of the editor(s), but without a following “ed(s).” This is contrary to the recommendation of CMS, which treats editions of ancient works like modern ones. 

Shackleton Bailey, D. R. 2003. Statius. Silvae. Cambridge, MA.

When the ancient author’s name is given before the title of his work, the name is followed by a period. This contrasts with situations where a name is the actual title of a modern work (e.g. Caesar: Politician and Statesman).

If the ancient author’s name is integrated into the title of the edition, there is no need to give it separately.

Clausen, Wendell. 1992. Persi Flacci et D. Iuni Iuvenalis Saturae. Oxford.

Edition of a modern work

These are listed under the author’s name. An editor (and/or translator [name preceded by “Trans.”]) is listed after the title. 

Lord, A. B. 2000. The Singer of Tales. 2nd ed. Ed. S. Mitchell and G. Nagy. Cambridge, MA.

Even if there is more than one editor their names are preceded by “ed.” not “eds.” In this position, “ed.” stands for “edited by” rather than “editor(s).” 

Dissertation

Beck, Deborah. 1997. Points of Departure: Variation in Homeric Speech Frames. PhD diss., Harvard University.

It is not necessary to give a place of publication in addition to the university, unless there would be ambiguity otherwise.

Article

Hollmann, A. 2011. “A Curse Tablet from Antioch against Babylas the Greengrocer.” Zeitschrift für Papyrologie und Epigraphik 177:157–165.
Scholtz, A. 2002–2003. “Aphrodite Pandemos at Naukratis.” Greek, Roman, and Byzantine Studies 43:231–242
Compton, T. 1990. “What Are the Topnoi in Philebus 51c?” Classical Quarterly, n.s., 40:549–552.

Review

Munson, Rosaria Vignolo. 2001. Review of Divinity and History: The Religion of Herodotus, by Thomas Harrison. http://bmcr.brynmawr.edu/2001/2001-06-22.html.
Hyperlink

Bakker, E. n.d. “Rhapsodes, Bards, and Bricoleurs: Homerizing Literary Theory.” In The Homerizon: Conceptual Interrogations In Homeric Studies (= Classics@ 3). http://chs.harvard.edu/wa/pageR?tn=ArticleWrapper&bdc=12&mn=1311.
Note: Websites, especially smaller ones, can change frequently. If you have any reason to question the permanence of a URL or if the data is time-sensitive, please add a parenthetical note, e.g. “(accessed on October 12, 2010).”

4. Punctuation

This section highlights areas of frequent confusion; please refer to CMS for more details.

4.1 Quotation marks

4.1.1 Double quotation marks

Double quotation marks enclose article titles and short direct quotes. Commas and periods are placed inside closing quotation marks (however illogical it may seem); colons and semicolons outside. 

Question marks and exclamation points are placed where they logically belong, so inside the quotation marks if they are part of the quotation. Contrast the quoted question with the question containing a quote, below.

He asked, “Is it too much to hope that you understand Cantonese?” So why did she reply, “I speak Japanese very well”?

4.1.2 Single quotation marks

Single quotation marks are used for a quotation within a quotation as follows: “In Africa the saying goes, ‘In the bush, an elephant can kill you, a leopard can kill you, and a black mamba can kill you. But only with the mamba … is death sure.’”
 Note the period inside both sets of quotation marks.

Single quotation marks are also used for glosses of non-English words, in which case any punctuation follows the closing quotation mark: “She claimed to speak Japanese hěn hǎo ‘very well’.” Note the position of the period outside the closing single quotation mark (outside the gloss), but inside the double.

4.2 Parentheses and square brackets

Square brackets are used inside parentheses instead of another set of parentheses. They may also be used for words or letters not present in a quotation, but supplied by the quoter, e.g. “αὐτὸς [Zeus] δ’ ἐκ κεφαλῆς γλαυκώπιδα γέινατ’ Ἀθήνην (Hesiod Theogony 924).”

4.3 Hyphens and dashes

4.3.1 Hyphen (-)
A hyphen is used for, among other things, phrasal adjectives, e.g. “fifth-century Athens” or “nineteenth- and twentieth-century scholarship.”

When capitalizing hyphenated words, capitalize both elements in headline-style (Inscribing Sorrow: Fourth-Century Attic Funerary Epigrams). In sentence-style, if the hyphenated word is the first word, only capitalize the first element.
4.3.2 En-dash (–)
The slightly longer en-dash (typed option-hyphen) is used for inclusive number ranges such as pages and years, e.g. “924–929.” If you cannot generate an en-dash, please use two unspaced hyphens to facilitate automated replacement.

4.3.3 Em-dash (—)
The considerably longer em-dash (typed option-shift-hyphen) is used, normally in pairs, for sudden breaks in a sentence or to set off a nearly parenthetical remark or aside: “But if you want to be old-school about it—and you know I’m all about old-school—then we can wait until dawn …”
 If you cannot generate an em-dash, please use three unspaced hyphens.

Three em-dashes, unspaced, are used in bibliographies for additional works by the same author(s)/editors(s). See above under “Bibliography.”

4.4 Slashes

4.4.1 Forward slashes
When used for lines of poetry that are run into the text, leave one space on either side of the slash: “You would be another Penelope: yet, they say, all / the yarn she spun in Ulysses’ absence did but fill / Ithaca full of moths.”

When used to signify alternatives/equivalents, space is not normally used, e.g. “Athena/Mentes.”
4.5 Other punctuation

4.5.1 Apostrophe

For ancient names ending in -s or -z, form the possessive simply by adding an apostrophe: “Hercules’ labors.” For modern names, add apostrophe + s: “Dodds’s commentary.”

No apostrophe is needed when speaking of decades, e.g. “the 390s AD.”

4.5.2 Comma

A comma separates all items in a series of three or more and precedes the conjunction before the last item: “Aeschylus, Sophocles, and Euripides” not “Aeschylus, Sophocles and Euripides.” See also under 4.5.5 “Semicolon,” below.

Do not use a comma between the name of an author and work: “Virgil Aeneid 1.490” not “Vergil, Aeneid 1.490.” Also, please do not use a comma after the abbreviations “e.g.” and “i.e.”

4.5.3 Ellipsis

A space should precede the ellipsis, unless it begins a sentence. A space should also follow the ellipsis, unless it is followed by other punctuation. See the example under 4.1.2 “Single quotation marks,” above. A three-dot ellipsis ending a sentence does not need to be followed by an additional period; see the example under 4.3.3 “Em-dash,” above.

4.5.4 Equals sign

In non-mathematical contexts, a space should be used on either side of an equals sign, unless other punctuation immediately precedes or follows, e.g. “Iliad 3.329 = 7.355 = 8.82.”
4.5.5 Semicolon

A semicolon may be used to separate items in a series of three or more when the individual items contain commas that would make distinguishing the items difficult.

4.5.6 Space

Please do not use double spaces between sentences or double returns between paragraphs.

5. Numbers

Use arabic, rather than roman, numerals wherever possible, both in numbering your own chapters/sections and in references, unless the reference is to pages or plates numbered with roman numerals in the original. 
5.1 Cardinal numbers

In non-technical contexts, cardinal numbers from zero through one hundred should be written out. If circumstances are such that adherence to this rule would cause a mix of number words and numerals in close proximity, some liberty may to taken to make the text more consistent.
5.2 Ordinal numbers
In the course of normal prose, ordinal numbers should be written out: fifth century BCE, not 5th century BCE. When abbreviated ordinals are used (e.g. in the bibliography), the ordinal is not superscripted.

5.3 Ranges

Numbers in inclusive ranges should be written in full and separated by an en-dash (see above, 4.3.2).
6. Abbreviations

6.1 Ancient works

Write out personal names and titles in full, e.g. “Cicero Orator 168” (not “Cic. Orat. 168”).
6.2 Abbreviated titles of modern works

Titles of journals should be given in full and italicized. Very common reference works (e.g. FGH, IG, LSJ, LIMC, OLD, OCD) may be abbreviated. If so, they are not italicized.
6.3 Common academic abbreviations

 Abbreviations such as e.g., i.e., s.v., cf. are not italicized, but ad, ad loc., and sic are normally italicized. See under “Comma” (4.5.2) for the omission of commas after “e.g.” and “i.e.”

6.4 BC, AD, BCE, and CE

Set as full-size caps (not small caps), without periods or space between the letters. Use either BCE/CE or BC/AD consistently. AD precedes the specific year or years, but follows decades or centuries (e.g. “AD 79” but “the 390s AD”). “Circa” should be abbreviated ca., rather than c.

6.5 Pages and notes
References should normally take the form “1998:37n51” (without periods or spaces). When citing pages or notes without a year, use the format “pp. 76–80” or “n. 19.” Please do not use “ibid.” or “loc. cit.”
“f.” and “ff.” are to be avoided. Please follow the example “1994:34–35” not “1994:34f.” Note that all numbers are written in full: “34–35” not “34–5.”

In citing line numbers, avoid “l.” and “ll.” (or “v.” or “vv.” for poetry); use plain numbers or write out “line” or “lines.” Exx: “there follows a lengthy section in anapaests (124–146)”; “Pindar develops the image further in lines 43–46.”

Important Tips for Applying Styles

In order to make the paragraph styles (see below) extra-visible in Microsoft Word, you can view the text you are creating in “Draft” mode (go to the View menu, and select “Draft”). Then set a Style Area Width in the Preferences (or in Windows, the Options) for Word, which will create a column to the left of your document that displays the name of any and all paragraph styles in the text. On a Mac, go to Preferences (in the Word menu) and click View. You will see a box labeled Style Area Width—type in 1.5” or 2” to make the style tags visible. If you are using Windows, go to the Tools menu and stop at the bottom, where you will find the Options menu item—stop there and a window will come up with many levels of tabs on the top. Click on the View tab and you will see a box in which to type a Style Areas Width of an inch or two.

There are several ways to apply style tags to paragraphs or characters in your document:

1. This template contains a floating toolbar containing all the CHS styles arranged by function. It should appear when you open up a document from the template; in some versions of Windows, they will appear scrunched up on the right side of the screen, and you can move them from there by passing your mouse over the bar above them and dragging them to another part of your desktop. To use the paragraph styles, just place your cursor in the paragraph that you wish to tag, then click on the tag you wish to use in the floating menu. To use the character styles, select the text that you want to tag and then click on the tag in the character style toolbar. If the toolbar does not appear, go to View ( Toolbars ( CHS Styles; after clicking, a check-mark should appear next to “CHS Styles” in the menu, and the toolbar should be somewhere on your screen.

2. If you use the Formatting Toolbar (go to View ( Toolbars ( Formatting), it contains three small boxes, one for style tags, the second for font names, and the third for font sizes. The best way to use the style tag box is to either select the text that you want to tag (for character styles) or to place your cursor in the paragraph whose tag you wish to change, then click in the style box and type in the abbreviation of the tag you wish to apply, followed by a carriage return. All the CHS style tags have an abbreviation, which consists of the two or three letters that appear after the comma in its unabbreviated name. For example, the abbreviation for chs_normal is no; that of chs_foreign_highlight is fhi.
3. You can also select styles from the Formatting Palette. If it is not visible, choose View ( Formatting Palette from the menu bar in Word. This method is not very efficient; picking from a list is easier with the dedicated CHS Styles toolbar described under item 1, above.
4. The most laborious way to apply style tags is to go to Format ( Styles… and scroll through the list of styles until you find the one that you want. Not recommended! 
Help

Questions and feedback about this template and the incorporated style guide may be directed to Ivy Livingston (ivy@chs.harvard.edu). Questions about artwork and permissions may be directed to Jill Curry Robbins (jcrobbins@chs.harvard.edu). The Director of Publications and IT is Leonard Muellner (muellner@chs.harvard.edu).
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Appendix 1: Alphabetical List of Paragraph Styles

	Style name
	Usage
	References

	biblio
	bibliography entries
	3.1

	blockquote
	prose quotations set apart from the text
	1.4

	caption
	figure captions
	1.8

	chapter_number
	number of chapter at chapter opening
	1.1.1

	chapter_subtitle
	subtitle (optional) at chapter opening
	1.1.2

	chatper_title
	title at chapter opening
	1.1.2

	essay_author
	name of author at chapter or essay opening
	1.1.3

	h1
	first-level subheads
	1.3

	h2
	second-level subheads
	1.3

	h3
	third-level subheads
	1.3

	list_continue
	additional paragraphs in a listdef_description
	1.7.4

	listbullet_item
	items within a bulleted list
	1.7.2

	listdef_description
	definitions or descriptions of items in definition lists (see listdef_term below)
	1.7.4

	listdef_term
	terms to be defined in definition lists
	1.7.4

	listnumber_item
	items within a first-level numbered list
	1.7.3

	listnumber2_item
	items within a nested numbered list
	1.7.3

	listsimple_item
	items within an unmarked list
	1.7.1

	normal
	normal, indented text paragraphs
	1.2.1

	normal_continue
	paragraphs resumed after a blockquote, vel sim.
	1.2.2 and 1.4

	normal_posthead
	paragraphs beginning after a subhead; first paragraph in a chapter
	1.2.1

	source_attrib
	after blockquotes or verse lines, to cite the source or credit a translator or editor
	1.6. See also 1.4, 1.5

	verse_line
	lines of poetry set apart from the text
	1.5


Appendix 2: Alphabetical List of Character Styles

	Style name
	Usage
	References

	citetitle
	titles of books, journals
	2.3.1

	citetitle_common
	titles (or abbreviations) of common reference works
	2.3.2

	Default Paragraph Font (not a chs style)
	undoes applied character styles and reverts to the underlying style of the paragraph
	2

	emphasis
	emphasis of the original speaker/author
	2.2

	foreign
	isolated foreign words and phrases
	2.1.1

	foreign_emphasis
	combination of foreign and emphasis
	2.2

	foreign_highlight
	combination of foreign and highlight
	2.2.1

	Greek_high
	combination of Greek and highlight
	2.2.1

	Greek
	isolated Greek words and phrases
	2.1.3

	highlight
	“quoter’s emphasis”
	2.2

	Latin
	isolated Latin words and phrases
	2.1.3

	Latin_high
	combination of Latin and highlight
	2.2.1

	msfam
	manuscript family
	2.4.1

	subscript
	subscripted indexing numbers
	2.4.2

	superscript
	superscripted edition numbers
	2.4.3

	translit_Greek
	transliterated Greek
	2.1.2

	translit_Greek_high
	combination of translit_Greek and highlight
	2.2.1

	verse_number
	line numbers in poetry (verse lines)
	1.5.1


� Epigraphs at the start of a chapter should be formatted as blockquotes or verselines (see 1.4 and 1.5 below) as appropriate. Epigraphs must be preceded by a blank line tagged chs_normal; this is to prevent their disappearance during conversion to digital format and will be removed before publication.


� See 1.6 below for formatting of the source attribution.


� Note that if you open the template by starting up Microsoft Word and using the Open command under the File menu to open the template file, you will open the template itself, you will not create a document that includes it, and you will not be able to save your document as a document, only as another template!


� The fonts used in this template are Gentium Plus and Lucida Grande (for both Greek and Latin-alphabet languages). The latter is standard on every Mac OS X system; Gentium Plus is freely available from <http://scripts.sil.org/cms/scripts/page.php?site_id=nrsi&item_id=Gentium_download> in versions for Windows, Macintosh, and Linux/Unix. There is no free version of Lucida Grande for Windows or Open Office users, but Windows and OO will display and print the words that use it in a default font; you can take the trouble of substituting another (Unicode) font for Lucida Grande if you wish to. If you use other Unicode fonts, the template will still function properly. If you have used older, non-Unicode fonts, see the “Help” section near the end of this document before you begin.


� These words are italicized because they are tagged chs_emphasis, which is a character style (see section 2 “Character Styles”).


� There are several other ways to apply styles; see the “Important Tips for Applying Style Tags” section near the end of this document. 


� Capitalize all major words; only capitalize a preposition or conjunction if it is the first or last word.


� The first word of both the title and subtitle are capitalized; otherwise only capitalize words that would be in normal prose of that language (e.g. nouns in German, proper names in most languages). Note that a definite or indefinite article counts as the first word.


� Notice that when set apart from the main text, Latin (and other languages) are not italicized.


� Note that a clearly incomplete verse line like this need not end in an ellipsis.


� You may name a translator in a footnote instead, whether for each translation or, in the case of the same translation being used throughout, in a single note at the first instance.


� Hěn hǎo ‘(very) well’. Tarantino 2003–2004.


� “You are here to learn the mysteries of kung fu, not linguistics.” Tarantino 2003–2004. The diacritics here are one of the benefits of a good Unicode font like Gentium Plus. You will not need a different font for macrons, breves, carons, etc.


� The author draws attention to the word caeca by tagging it Latin_high (see 2.2.1).


� Tarantino 2003–2004.


� The work edited by Dué appears between two works authored by her.


� Note that the ordinal (2nd) is written in shortened form but not superscripted.


� Note that the period after this title goes inside all the closing quotes. See also under 4.1 “Quotation marks.”


� Here the question mark is part of the title, but not part of the phrase “Ladder of Love,” and so is placed inside the quotation marks that surround the title as a whole, but outside those that surround “Ladder of Love.”


� Dialogue from Tarantino 2003–2004.


� Tarantino 2003–2004. Note that the citation is repeated, although the same as in n5. Please do not use op. cit. or ibid.


� Tarantino 2003–2004.


� Shakespeare. Coriolanus, act 1, scene 3.





